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Professional filmmaker, photographer and visual 
artist Peter Scheer will be our guest speaker at 
the March general meeting. Peter received a BA 
from Long Island University, followed by a Pratt 
Institute Fellowship in Art. His photography, art 
and film works have been covered by Newsday, 
The New York Times, Life magazine, and other 
major publications.

As a documentary filmmaker/photographer, 
he has traveled extensively conducting photojournalistic excursions 
through the Middle East, Europe, Liberia, Somalia and Ethiopia. He 
has shot and edited presentations for the World Health Organization 
and UNICEF that dramatize the fight against TB, which is still a 
major global initiative. His work has aired on the HBO Ali ‘G’ Show, 
NOVA, A&E, Bravo, Rainbow, Nightline, ABC, CBS, NBC, PBS, 
MTV, Sesame Street, and Nickelodeon, as well as Canadian and 
European television.

Peter’s presentation will cover the Fantasy Faerie project and 
how it evolved, from its origins to the present.  He will show the 
techniques he used to reach the final result of the more complex 
images, with the aim to illustrate how to incorporate and blend a 
diverse number of images and seamlessly combine them into one 
overall concept shot.

Special note from Peter: “There will be nude images (attractively 
shot) so please be forewarned if there are any members who have 
any issues about that.”

As is our custom, the meeting will begin with our two Q&A ses-
sions (Bradley’s in the main room and the MacBasics across the hall), 
which will be followed by Peter’s presentation in the main room. 
The general meeting concludes with announcements and our ever-
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Our February meeting, scheduled for February 14, was in 
jeopardy of being cancelled due to the weather. Luckily Mother 
Nature cooperated, and we were able to have the meeting. I must 
say, I am glad we did. This was one of the most interesting, infor-
mative, and fun presentations we have had. Our presenters were 
Adam and Tonya Engst of TidBITS and Take Control Ebooks. 
I am sure most of you know TidBITS. They have been around 
since April 1990. My first experience with TidBITS, involved 
getting my first Mac on the Internet. Adam had written a book 
called; the Internet Starter Kit for Macintosh. I successfully got 
full Internet access using this book, and the included diskette, 
which contained all of the software necessary to get online, 
send e-mail, and download files. Now, I go to the TidBITS site  
http://tidbits.com/ regularly to read the articles. and see what is 
new. If you look at the upper right of the TidBITS home page 
you will see: “Become a TidBITS member.” If you click the link, 
you will be taken to a page that lists the advantages (and they 
are numerous) of membership. 

Adam started by telling the membership that TidBITS is the 
oldest internet-only publication. To date, there have been 1212 
issues. It is also the first web site to have advertisements. Then, 
Adam began the topic he came to present; Take Control Ebooks. 
He explained, that e-books are better for both the author, and 
the publisher. With an e-book, both parties get more income 
from a book that they can sell for less than a print book. He 
described how he developed his method for publishing these 
books. He went from a very cumbersome process of starting 
with Microsoft Word for Windows, (the Windows version had 
certain features he and Tonya needed) then importing into 
Microsoft Word for Mac to do the formatting. They related, 
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For our February meeting we were honored to have 
Adam and Tonya Engst visit Long Island. For them 
it was an adventure that began with walking through 

knee deep snow following a storm that covered Ithaca all the 
way south to Long Island. That is commitment that we could 
not expect but truly appreciated. On our end, we had a better 
turnout than expected considering the weather, and we were 
rewarded with a wonderful presentation on how TidBITS and 
TakeControl were started and grew to the great resources they 
are today. That in itself may not sound that interesting if it 
weren’t for all the personal highlights and anecdotes the couple 
sprinkled through their presentation. That made for a great eve-
ning, which ended with some tips on a most important subject 
everyone could relate to, that of passwords.  At the end of the 
presentation our members rewarded Adam and Tonya with a well-
deserved standing ovation. We hope that they may again return to 
LIMac without such a long hiatus.
Bill Medlow

| I’ve just downloaded 
the OS X 10.9 Mavericks 
upgrade and I’ve got a 

question about the upgraded Mail pro-
gram. I found there was a way of not 
removing the dot that indicates that a 
message is unread. I guess the new viewing 
layout is confusing me. ?
■ The modern viewing layout, much like 
that found on a iPad, shows a preview pane 
for the selected message, thus opening 
and reading it. If you drag the border of 
the list column and the message body 
column to the right, collapsing the right-
most column, then selecting one or more 
messages will not mark it read. If you do 
double-click on a message to read it, you 
can later mark it as unread, by either using 
the command-shift-u keyboard shortcut or 
selecting from the Message menu, Mark 
- As Unread or you can use the add the 
Unread/Read button pair to the toolbar by 
using the View menu - Customize Toolbar 
command. Considering you could get a 
spam message with an embedded javascript 
that confirms your e-mail address, it’s safest 
to not have the preview pane, so you can 
delete messages without ever opening or 
previewing them. 
  On a related matter, I thought I’d men-
tion that the Snow Leopard version of Mail 
had a Bounce message function, but later 
versions do not. There is a free 3rd party 
application that could install a toolbar item 
for bouncing e-mail which worked in Lion 
and Mountain Lion, but not Mavericks. 

| Have you been getting a “blocked 
plugin” message in your web browser 
lately? It’s because Apple blocked the old 
Adobe Flash Player plug-in. Get the new 
12.0.0.70 to restore functionality.
■ The XProtect system or “safe down-
loads list” introduced as File Quarantine 
with Leopard and expanded to include 
protecting against malware with Snow 
Leopard. Savvy applications include Safari, 
Messages, iChat and Mail. Apple silently 
updates the XProtect definitions on your 
Mac daily ever since Security Update 
2011-003 was installed (presumably on 
June, 1, 2011), which can then disable 
certain functions like (Oracle, formerly 
Sun) java web apps or Adobe Flash Player 
when vulnerabilities are found. That update 
killed the MacDefender malware if found. 
Hopefully soon thereafter, an update is 
released and you can update and get the 
functionality back. OS X Lion and later 
expanded on the quarantine function by 
including Gatekeeper, which can be con-
trolled to some extent with the Security & 
Privacy System Preference panel. If you’d 
like to keep up on the latest Mac security 
issues, check out The Safe Mac web site. 
The modern Adobe Flash Player plug-in 
comes with a companion System Preferences 
panel, whose Advanced tab allows you to 
check for and download the latest general 
release. The beta of the next release can 
be found here.
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| I’ve heard that it is best to delete an 
e-mail without ever opening it, if it’s from 
an unknown sender? Mail seems to make 
that impossible. Isn’t there a way?
■ The default view in Mavericks’ Mail 
program includes three columns; mail-
boxes, list of messages with short 2 line 
preview and then the full body. You can 
collapse the right-most column by drag-
ging the vertical divider to the right. Then 
use the Preferences - Viewing to change 
the List Preview to None. If you notice 
carefully there is a dot at the center of the 
right border, which you can use to drag 
back the preview pane. Double-clicking 
on it will also bring it back to a narrow 
column. Now here is what I do: I created 
a New Mailbox on my Mac, called ‘suspect 
sender’ and then created a rule (in prefer-
ences) like this:

 

Now any spam gets sorted out of my 
Inbox. I can then select any message, add 
the sender to my address book to keep any 
future messages from them out of the sus-
pects. I can drag that first one into the 
Inbox.

| I seem to have some difficulty organizing 
my files. I used to be able to use Microsoft 
Word and save all my stuff in a folder, but 
I don’t know how to do that now.
■ It’s the same as always, but there are 
some nice shortcuts available. You can 
create folders in the Finder, hopefully in 

the Documents folder. By default, the 
Documents folder can be found in the 
shortcut in the sidebar and the shortcut in 
the Dock. Failing those, you can use the Go 
menu in the Finder to get your Documents 
folder, or the keyboard shortcut command-
shift-o. There you can make a new folder 
from the File menu, and name it some-
thing useful. If you will be working with 
this folder frequently, you can drag it (as 
an alias) to the sidebar under the places 
group. If a folder in the sidebar is no longer 
a hot interest, you can control-click on it 
and select Remove from Sidebar from the 
contextual menu. In the Finder, you can 
open a second window, navigate to where 
some errant file was saved and drag it to the 
other window that has the proper folder’s 
contents visible.
   Once you are running Word and have 
selected Save As... from the File menu, you 
should get the standard dialog box. It’s 
possible this dialog box has been shrunk to 
a simplified version. If so, click the down 
arrow in a box to the right of the edit field 
where you can type the name of your file 
to be saved. That should get you the full 
dialog box where you can see a folder 
structure and sidebar. The sidebar portion 
can be made wider. This whole window 
can be enlarged and the list shown in one 
of three ways, by icon, list and 3 column 
view much like a normal Finder window. 
Notice that your new folder will be shown 
in the places section of the sidebar. You 
can click on that, to jump to that folder. You 
should also notice the New Folder button 
at the bottom-left where you can create a 
new folder and name it at the current folder 
as shown in the pop-up menu at the top of 

the list. Just about every Mac application 
offers the New Folder button in the Save As... 
dialog box. You can drag more folders to the 
sidebar here as well. If you click on the name 
of an existing document here, your new file 
will take on the same name, which you can 
then edit to avoid overwriting the old file. Of 
course the same kind of window comes up 
when you select Open… from the File menu. 
You can navigate to whatever folder you want, 
jump to whatever folders are in the sidebar. 
If you want to open more than one file at 
a time, you can click on the first and then 
command-click on the succeeding ones and 
then click the Open button and they all open 
in separate windows. You can even then use 
the Window menu’s Arrange All to re-size 
each window to narrow horizontally stacked 
windows, each with a ribbon for formatting. 
    Word also has it’s Document Gallery which 
you can get to by selecting Open Recent... 
and selecting More... and you should see a 
list called Recent Documents in the lower-
left with choices like All, Today, Yesterday 
and Past Week. Selecting one, you should 
then get a window pane with thumbnails of 
your recent files for you to pick, regardless 
of which folder they were saved in. There is a 
slider near the bottom where you can re-size 
the thumbnails in order to see more detail or 
more choices at once. There is also a small 
triangle near the top-right where you can 
hide a better preview with some info in order 
to show many more thumbnails at once. 
With a little practice and care in saving your 
documents in the right folders and naming 
those folders with useful names, you should 
be able to find your files easily. 
    Failing that organization, you could always 
rely on the Spotlight search function of the 

Finder to find your documents by content, 
so you don’t have to remember the file name 
nor the file location. When you do find them, 
I’d drag them to where they belong. You 
probably want to use the Finder’s View menu 
- Show Path Bar to keep better track of the 
location of a given folder. Don’t be afraid of 
creating deeply nested sub-folders to keep 
things tidy. Maverick’s new Finder Tags can 
help identify files in the same folder. The 
older operating system’s more limited labels 
where you can assign only one to a document 
is still valuable for sorting your various in-
process and finished files.

| You’ve said before that a cluttered desktop 
will use up a lot of system resources. How 
can you tell and does Windows have the 
same problem?
■ I’d take a look at the CPU percentage 
usage with Activity Monitor, then move all 
your icons from the Desktop to a folder in 
your Documents folder, restart and look 
again with Activity Monitor. The worst situ-
ation is when you have the View Options 
set to show both icon previews and item 
info. The Mac has to render the first page 
of every PDF and Word or Excel document 
and every multi-layer Photoshop file. Add to 
that the pixel dimension for each image and 
the item counts for folders. That has to be 
updated every second. How could it not 
slow things down. I’ve heard of situations 
where at some point, a couple of thousand 
icons got dragged to the desktop, causing a 
serious slowdown and spinning beach balls. 
The user dragged the visible icons away, 
but there were others hidden under the 
dock or just in a corner and not noticed. 
The Mac was still slow. Only when the 
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window for the Desktop was opened, as a 
list, was the obscured icons seen, collected 
in a folder and moved elsewhere. The worst 
case is when there is a image’s icon on the 
desktop and it gets corrupted. The Mac is 
constantly trying to render the icon pre-
view and locks up. So if your Mac boots but 
the Finder doesn’t load, perhaps you never 
see the full menu bar and dock, it may be 
because of a bad icon left on the Desktop. 
The other problem with too much stuff on 
your desktop is it is all too easily trashed by 
accident. We know that extending a selec-
tion discontiguously by command-clicking, 
but you could have a folder or file selected 
and you command-click on what you think 
is your first selection, but it’s your second 
or third. You then drag to the trash the 
files you have been paying attention to. 
Perhaps just using the command-delete 
keyboard shortcut to trash the selection. 
You then empty the trash. Perhaps days 
later, you look for a folder on your desktop 
and it’s gone. Surely you didn’t delete it. 
You don’t remember trashing it. It was 
and is important. Well who else snuck into 
your home, turned on your computer and 
deleted nothing but this folder? It’s the 
definition of an accident YOU did. 
    Think that’s bad, a client of mine 
was using an old version of QuickBooks. 
His main file and the backup was on 
the desktop, perhaps in a folder. There 
were plenty of other important files on 
the desktop too. A bogus update for 
QuickBooks dialog came up, it was OK’d 
and proceeded to delete the Desktop folder 
and it’s contents in an instant. No backup. 
He had to recreate months of work from 
a backup copy I had made to another 

computer. He sued Intuit and got a free 
upgrade to the next version, but it was a 
major problem for his business. You know 
the old warning about putting all your 
eggs in one basket? I did not know about 
Windows desktop usage at the meeting, but 
I looked it up and it seems to not have this 
problem. Good for them. It makes up for 
the 300,000 viruses.

| I know that you need to keep 10% free 
disk space on your Mac to keep things run-
ning. Does the iPad have a similar guide-
line?
■ Well actually the Mac would like to see 
20% free disk space on your startup disk 
for virtual memory, caches, print jobs and 
other assorted temporary files, but things 
get really problematic at the 10% level. Also 
for old school spinning hard drives, as they 
get filled, they get slower. As for the iPad, 
that’s a good question as Apple never has 
said anything on this issue. It doesn’t use 
the same backing files for virtual memory, 
so the free space requirement would be 
much lower. I’ve heard of a fellow who 
regular got his iPhone down to 50MB free 
before it started acting up. If you are run-
ning too low on space to install a desired 
App. or iOS upgrade, consider using a 
program like PhoneClean from iMobie Inc. 
which can clear caches and help remove 
storage wasting large applications.

User Group Offers
George Canellis
User Group Ambassador & 
Vice President
gwc11713@optonline.net

A subscription to KelbyTraining is a 
“must-have” for photographers, graphic 
designers, and anyone that’s serious 
about taking their photography skills 
to the next level. It’s the perfect way to 
learn at your own pace, on your own 
time. Best of all, you get access to their 
online catalogue wherever you are, so 
you can replay specif ic clips or even re-
peat the entire class if you like. Most 
classes also come with the exercise f iles 
that the instructor used so you can fol-
low along! For less than the cost of an 
average tripod you can study online for 
an entire year at the planet’s premier 
photography educat ion dest inat ion. 
Save $10 off an annual subscription. 

Online radio stations run by real peo-
ple,  not generated by computers. 
Live365 VIPs enjoy commercial-free 
music and talk from the web, mobile, 
and all Live365-enabled devices. Your 
saved stations are stored in the cloud, 
so access them everywhere you happen 
to be. Get ultimate, commercial-free 
access to 7,000+ stations, better sound 
and support your favorite DJs. Get 25% 
off Live365 VIP. 

Bring back the familiar feel and sound 
of a clickety-clack keyboard with the 
Das Keyboard Model S Professional for 
Mac. It sports best-in-class, German-
engineered mechanical gold-plated key 
switches which provide a tactile and au-
dible click that makes typing pure joy. 
It also has a two-port USB hub as well 
as Mac specif ic special keys. The Das 
Keyboa rd Model S for Mac a l lows 
5-key rollover, i.e. 5 keys pressed simul-
taneously. Great for gamers and fast 
typist. 

NCH Software maker of Mac OS X 
software for business, audio conver-
sion, vinyl to CD, MP3 recorder, video 
editing & more. 

Carrot Ink offers premium ink car-
tridges, laser toner and printer sup-
plies for Brother, Canon, Epson, HP, 
Lexmark and Samsung without the 
premium price tag. You won’t have to 
think twice when you use Carrot Ink. 
Save 10% and free shipping on orders 
over $50. 

Over the years, Corel has brought a spirit 
of innovation to the development of a 
range of award-winning products that in-
cludes graphics, painting, photo, video 
and off ice software. Corel also earned 
a reputation for delivering high-quality 
products that are easy to learn and use, 
and help people achieve new levels of 
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User Group Offers continued on Page 6

productivity. But more than that, they’ve 
built a relationship with a community of 
users—now 100 million strong. Get spe-
cial offers on great software by visiting: 

You know that you’re ready to install 
more R AM in your desktop or note-
book, but you’re not sure which mem-
ory module is right for your particu-
lar Mac. Crucial has the tools to make 
f inding the r ight memory upgrade 
fast and easy and Crucial memory has 
a limited lifetime warranty and comes 
with free shipping!  

Boston Acoustics’ MC200Air is a high 
performance wireless speaker system 
for AirPlay. AirPlay wireless technol-
ogy lets you stream your favorite mu-
sic from your Wi-Fi connected PC 
or Mac using iTunes, or your iPad, 
iPod Touch, or iPhone device to your 
MC200Air Speaker System. Normally 
$399,

Founded in 2002, Big Fish is the world’s 
largest producer of casual games; dedi-
cated to bringing engaging entertainment 
to everyone, anywhere, on any device. 
Through its proprietary, data-driven plat-
form, millions of consumers seeking en-
gaging entertainment easily discover and 
play computer and mobile games created 
by Big Fish’s network of more than 600 
development partners and its in-house Big 
Fish Studios. Big Fish offers a new game 

every day for Mac, PC and Big Fish Un-
limited players. There are over 350 games 
available on iPad and iPhone. Big Fish has 
a library of 3,000+ premium download-
able games. 

Tech Armor Ballistic Glass Screen Protec-
tors are the clearest protection available 
for your Apple iPhone 5 Retina displa 
and Apple iPad mini. Made of hardened 
tempered glass only .4mm thick, they  
offer the ultimate in protection for your 
iPhone 5 and iPad mini without sacrific-
ing clarity or touch screen sensitivity! All 
Tech Armor Screen protectors are made 
of the highest quality tempered glass 
available with 100% bubble-free silicon 
adhesives. Save 25% off Tech Armor Bal-
listic Glass Screen Protectors today! 

 

ZAGG, maker of great screen protec-
tors (invisibleSHIELD), mobile key-
boards, cases, audio accessories and 
more.  

MacGameStore was launched in April 
2005 and since then has grown into 
the leading Mac-only distributor of 
digital download games with over one 
mill ion Mac games sold. Their goal 
is to provide the best shopping expe-
rience that Mac gamers deserve with 
hot new selections every day, excel-
lent customer service, daily specials, 
great bundles, and useful information 

to make purchasing decisions easier. 
MacGameStore’s special department 
is rolling out the amazing savings up 
to 75% on nearly 15 games, as low as 
$2.99. Visit:  

 

Apple user group members receive a 
35% discount when they shop at peach-
pit.com and 40% on all eBooks and vid-
eos. Just enter the user group discount 
coupon code at checkout. Ground ship-
ping is free! (This discount cannot be 
used in conjunction with any other cou-
pon codes such as the Peachpit Club.) 

Que Publ ishing has more than 32 
years of experience helping users learn 
about computers and technology for 
the home, off ice, and business. Their 
books,  eBooks,  and v ideos teach 
through step-by-step tutorials, are rich 
in illustrations, and provide in depth 
references on important topics includ-
ing OS X Mountain Lion, iCloud, Ap-
ple devices, and much more. For those 
interested in beginner to advanced Mac 
programming titles, visit Que’s partner 
site www.informit.com/store to see new 
releases from Addison-Wesley Pro-
fessional and Sams Publishing. Apple 
user group members can take advan-
tage of exclusive product discounts of 
35% off the list price of all print books 
and 45% off the list price of all eBooks 

and Video Training plus free U.S. ship-
ping every day.

 

To get 
started, visit: http://www.quepublishing.
com/store

M a c | L i f e  i s  T H E  A p p l e - p r o d -
uct magazine that changes a l l the 
ru les. Mac|Life recognizes Apple’s  
dynamic role in work, play and life and 
will appeal to core Apple users. With 
fresh insight, in-depth how-tos, stun-
ning design and  exclusive informa-
tion, Mac|Life helps users realize their 
ful l potent ia l. Mac|Life is the ult i-
mate magazine about all  things Ap-
ple. 

 

SlideShark from BrainShark, Inc. is a 
free app that converts PowerPoint pre-
sentations to view on your iPad. It is 
easy to use and designed with pro-
fessionals, educators, and students in 
mind. It preserves animations, fonts, 
graphics and colors, and allows you 
to tap or swipe to advance animations 
and slides. With SlideShark you can 
view and present your slideshow on the 
iPad the way it was meant to be seen 
(and show on your TV with the iPad 
2). See a demo at https://www.slideshark.
com/

User Group Offers continued from Page 4

www.informit.com/
http://www.quepublishing.com/store 
http://www.informit.com/store
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Too many passwords to remember? 1Pass-
word 3 for Mac is a password manager 
that goes beyond simple password stor-
age by integrating directly with your 
web browser to automatically log you 
into websites, enter credit card  infor-
mation, fill registration forms, and eas-
ily generate strong passwords. As an 
Apple user group member, you are enti-
tled to get the single user 1Password on 
the Mac for $29.99, well below the nor-
mal retail price of $39.99 ($52.49 for 
the 5-user family version, which is usu-
ally $69.99). You also get a 25% discount 
on everything in the Agile store. 1Pass-
word is separately available for the iPhone 
or iPad ($9.99) and iPad/iPhone combo 
($14.99) from the Apple iTunes Store. 

Get 40% off books and videos from 
O’Reilly, Microsoft Press, No Starch, 
Paraglyph, PC Publishing, Pragmatic 
Bookshelf, Rocky Nook, SitePoint, or 
YoungJin books and 50% off ebooks 
you purchase directly from O’Reilly. Or-
der from the O’Reilly Store online or by 
phone at 1-800-998-9938.

Eltima Software is a global software de-
velopment company, specializing in Flash 
software development for Mac users. All 
f lashers will see the true value of Flash 
Decompiler Trillix for Mac, Flash Opti-
mizer for Mac and SWF & FLV Player 

for Mac. With these products, manag-
ing Flash files is easy: decompile, com-
press or just play them back. Regular 
prices for Eltima’s Flash software range 
from $19.95-$99.95.  

 

Freeway gives you all the legendary 
ease-of-use and features that launched 
the desktop publishing revolution. You 
can quickly and effortlessly lay out your 
website, embed images and content, 
then publish your work as standards-
compliant HTML. Upload to your 
server, or to a folder. You supply the 
creativity, Freeway handles the code. 
LIMac members can buy Freeway Pro, 
regularly $249 for $186.75, and Free-
way Express for $59.25, a 25% discount. 
Build your website now. http://www.
softpress.com/store 

PowerMax.com, the engine behind The 
Apple MUG Store, is pleased to announce 
a new process for Apple user group mem-
bers. Instead of going to the Apple MUG 
Store website to view a limited selection of 
items, members can now go directly to the 
PowerMax website to peruse and purchase 
almost 50,000 products. By identifying the 
user group you belong to (either on an on-
line order or over the phone), PowerMax 
will continue to accumulate points for LI-
Mac to use. In addition to great deals, free 
UPS shipping is offered on any order over 
$50. Be sure to take advantage of this win/
win deal: http://PowerMax.com

User Group Offers continued from Page 5

RadTech manufactures and distributes 
an array of best-in-class accessory so-
lutions for Apple computers, iPhone, 
iPod and Cinema Displays, all designed 
to keep you connected and protected in 
style. Experience the RadTech differ-
ence through their unique product line 
and legendary customer support. LI-
Mac members get 20% off all products. 
Start saving now: http://www.radtech.
us 

No matter what Apple devices you’re 
using, there’s a Take Control ebook 
that will help you polish your skills, work 
more efficiently, and increase your pro-
ductivity. Check out our highly practi-
cal, tightly focused ebooks covering OS 
X, Macintosh applications, the iPad and 
iPhone, 802.11n networking, and more! 
Written by the most-trusted names in 
the Mac world and published by Adam 
and Tonya Engst of TidBITS, Take Con-
trol ebooks provide the technical help 
you need now. Take Control ebooks are 
available for  immediate download in 
PDF format (for Macs and iPads), and 

with EPUB (for iPhone and iPod touch) 
and Mobipocket (for Kindle) versions 
available after purchase. An exclusive 
30% off their already low prices is offered 
to Apple user group members on all Take 
Control ebooks. Purchase Take Control 
books

TidBITS: http://www.tidbits.com

Do you own or work in a Mac-based 
small business that has grown out of 
it’s computerized checkbook? Have you 
grown tired of creating invoices using 
InDesign or Word? If you think you 
are ready to move beyond your shoe-
box, MYOB has the right tool for you 
at a great MUG discount. MYOB, Inc., 
the leader in Mac small business man-
agement, has just released MYOB First-
Edge, a new Mac only product that will 
help you run your business quickly and 
easily. 

http://www.
myob.com/us/  0

popular raffle. The evening ends with the two 
SIGs meeting this month: MacBasics (across 
the hall) and Music (in the main room).

This promises to be an extremely inter-
esting meeting full of information about 
creating complex images through post pro-
cessing with Photoshop. I know I’ll be there!  
Will you? 0

| Will Apple be making Maps for the iPad 
better and if not, what else would you 
suggest? For hiking?
■ Well, they already did make major 
improvements since it’s first release, but 
you should try Google Maps and Waze 
as it includes crowd-sourced traffic info. 
Galieo Offline Maps is good for when you 
can’t use up your battery for GPS. Give 
AllTrails and Strava Run a look. 0

Bradley’s Tech Session continued from Page 4 March Meeting continued from Page 1

http://PowerMax.com
http://www.radtech.us
https://itunes.apple.com/us/app/google-maps/id585027354?mt=8
https://itunes.apple.com/us/app/waze-social-gps-maps-traffic/id323229106?mt=8
https://itunes.apple.com/us/app/galileo-offline-maps/id321745474?mt=8
https://itunes.apple.com/us/app/alltrails-hiking-mountain/id405075943?mt=8
https://itunes.apple.com/us/app/strava-run-gps-running-training/id488914018?mt=8


T H E  L I M A C  F O R U M  •  M A R C H  2 0 1 4  •  P A G E  7T H E  L I M A C  F O R U M  •  M A R C H  2 0 1 4  •  P A G E  7

General meeting time schedule:
Meetings are held at 
The New York Institute of Technology, 
Building 300 (Anna Rubin Hall),  
Old Westbury, Long Island.
For more detailed information about this location go to 
limac.org

Meetings start promptly at 7:00 p.m.
Bradley’s Q&A: 7:00 – 7:30 p.m.
MacBasics Q&A: 7:00 – 7:30 p.m. 
No MacBasics
Featured Presentation: 7:30 – 8:20 p.m. 

MacBasics SIG: Q&A session only 
iOS SIG: No known topic

| In bad weather, call (516) 686-7789.

| �The next LIMac board meeting will be at the Plainedge 
Library, (516) 735-4133, on Wednesday, March 19th, 
at 7:30 p.m. For more detailed information about this 
location go to limac.org 

For a Year’s membership
Send your $36 check to: 

Renewal
Membership renewal for 2014 takes place from now onwards. A 
bonus discount was passed by the Board of Directors a few years ago: 
Bring in a new dues-paying member and get a $12 discount off your 
membership renewal. Bring in three new members and your renewal 
is free!

Bringing in a new member also includes getting a past member 
back into the group.

Make your $36 check out to LIMac and bring it to the next meeting, 
or mail to LIMac, Post Office Box 2048, Seaford NY 11783-0180

How to better visually enjoy the Forum: Your Editor prefers 
you to use Adobe Reader 9 as long as your Mac meets the 
requirement of Mac OS 10.4.11 or newer. PostView 1.8 ($22) 
works from Mac OS 10.2 all the way up to 10.5 for PowerPC 
and Intel based Macs.  

West East

North

South

LI Macintosh Users Group 

P.O. Box 2048 

Seaford, NY 11783-0180

SPECIAL NOTICE 
This edition is made for viewing on your computer 
screen. If you want to print this version I have now 
compensated for some printers that don’t print too 
close to the edge, if however, you wish a more printer 
friendly edition without all the colors just email me at 
azygier@verizon.net and I’ll be happy to send you one.  
(Al Zygier)

February Meeting continued from Page 1

that sometimes they had to go back and 
forth between the Windows and Mac 
versions several times. This method was 
extra work, so they continued to look for 
a better one. When version 4 of Apple’s 
Pages came out, it supported creation of 
ePub files. They used that until Pages 
version 4.3 arrived. It seems that when 
exporting to ePub, version 4.3, handles 
graphics differently than previous versions. 
It changes the size of the images to the 
size they were, before being inserted into 
Pages. This change made their work much 
more time consuming, since they had to 
use a work-around, in order to restore the 
images to the desired size. Finally, they 
discovered Nisus Writer Pro http://nisus.
com/. This word processor had all of the 
tools they needed to create the ePub files, 
and this is what they use today. They are 
also using Leanpub https://leanpub.com/ 
to create books with incremental updates. 
Leanpub relies on Markdown language, 
and can export a book as PDF, ePub, and 
MOBI (Kindle format). If you are inter-
ested in learning more about Markdown 
language point your browser here: http://
whatismarkdown.com/.

All of this enables the TidBITS team 
to bring you great tech instruction books 
at a reasonable price. In addition, all of 
these e-books are irregularly updated for 
free. For example the new Take Control 
of Pages book http://www.takecontrolbooks.
com/pages is still in production. This is 
one of the Take Control Ebooks that is 
being done in conjunction with Leanpub. 
When you hit the buy button it takes you 
to the Leanpub site.  When you make 
your purchase, you can download PDF, 

ePub, and Mobipocket versions of the 
book. This book focuses on the transition 
from Pages 4.x to Pages 5. Since the new 
Pages is still in development, you will get 
updates explaining new features as they 
are added.

Last, Adam and Tonya talked about 
making your passwords safe. Yes, there 
is a Take Control Ebook for this, just 
click http://www.takecontrolbooks.com/
passwords, and read all about it. Here 
are some tips they gave for making your 
passwords more secure.

• First they gave some warnings. 
1-�Passwords are stolen from the com-

puters of major companies every day.
2-�The CPU power available today 

can crack 350 billion passwords per 
second.

- �He suggested using a password man-
ager like 1Password.

- �Another tactic is make your passwords 
long, at least 16 characters if allowed.

- �Your passwords should combine upper-
case letters, lowercase letters, numbers, 
and special characters if permitted.

- �Use information familiar to you, but 
arranged to look completely random.

To get the full impact of their presenta-
tion, you really had to be there. The way 
the worked off each other was seamless. 
They never even hesitated on a question. 
When they come back again, don’t miss it. 
In the meantime go to the TidBITS site, 
and see all the great stuff they have to 
offer. I for one, am really looking forward 
to their next presentation. 0

mailto:azygier%40nyc.rr.com?subject=
http://nisus.com/
http://nisus.com/
http://leanpub.com/
http://whatismarkdown.com/
http://whatismarkdown.com/
http://www.takecontrolbooks.com/pages
http://www.takecontrolbooks.com/pages
http://www.takecontrolbooks.com/
mailto:azygier@verizon.net
https://en.wikipedia.org/wiki/EPUB
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Alfred H. Choy, former LIMac Vice President and 
Internet SIG Chairman, 86 years old, passed away on 
February 28, 2014, following a second stroke. He was born 
in September 12, 1927. Al graduated Fordham University 
in 1947. He formerly lived in Syosset while he worked for 
Grumman. He contributed to the lunar landing module 
and later the F-14 Tomcat. He later became a higher educa-
tion consultant. Al had been a LIMac member since 1989 
and served on the board for many years. A few years ago,  
following Christmas, and after he moved to East Northport, 
he suffered a stroke.

In addition to his excellent computer skills, he was an edu-
cator, avid sailor, great speaker, and excellent cook. Al had 
a wonderfully wry sense of humor and had a wealth of fasci-
nating personal stories which he was always willing to share 
with his friends and colleagues. He will be sorely missed.

He is survived by his wife Patricia and his children; Alfred, 
David (& wife Jane), Gerald (& wife Tina), Elizabeth (& 
husband Michael), Joseph (& wife Heidi) and Michael (& 
wife Emile). He also left stepchildren James, Patti (& hus-
band Greg), and Kathleen (& husband Chris). Also grand-
father of fifteen and brother to Olga Maylan Monahan.

Donations in Alfred’s memory can be made to the  

VMS Hospice House  

505 Main Street, Northport, NY 11768. 

https://www.visitingnurseservice.org/support.html



